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1. Used Abbreviations and Introduction 

The following abbreviations are used in the DesktopReminder DR Manual: 

Abbreviation Description 

DR DesktopReminder 

CSV A common file format of text files 
INI Initialization(s) 

PDF Portable Document Format 

XLSM Microsoft Excel file format as of Office 2007 
ZIP The most popular compression format 

The DesktopReminder is a portable Windows program, i.e., it makes and needs no entries in 

the Windows Registry. It monitors the user appointments entered in CSV files and issues a 
reminder when an appointment is due. DesktopReminder runs on Windows 7 or higher in 32- 

and 64-bit versions. The DR is delivered in ZIP format. The ZIP file must be unpacked into a  user 
selected directory. After that, a shortcut with the DesktopReminder.exe file has to be inserted 

into the Windows AutoStart folder (see own chapter below), because the DR has to run 
permanently to be able to perform its calculations. 

The program interface consists of a list box in which all outputs (reminders, error messages) are 

entered, as well as control buttons and two combo boxes. The program can be controlled via 
the control buttons and the combo boxes. In total, more than 30 commands are available, which 

are described in detail in a subsequent chapter. If you check the Stop entries checkbox, no more 
entries will be made in the list box. If you uncheck the box, the entries will be continued.  

In the input field Days, you can enter a value of up to three digits, which will then be used for a 
preview or review in days when pressing the two buttons Future Events/Missed Events. For 

example, if you are returning from a 14-day vacation, you can enter 14 in the input field and 
then press the Missed Events button. Then the missed events within the last 14 days will be 

displayed. All types of outputs (reminders, notes, errors) are done in the listbox on the program 
interface. Additionally, the reminders are output in a message box or a text editor window. 

The DesktopReminder is bilingual, German and English. The language can be switched during 

operation. 

The DesktopReminder uses so-called Windows tooltips for assistance during operation. When 

moving the mouse over a button, the respective tooltip pops up to explain the button function.  

When moving the mouse over one of the buttons, its color changes to red to indicate that the 
button is now "armed" and its associated command will be executed when the left mouse 

button is pressed. 

Notes on errors in the appointment configuration: 

A line in an event configuration file defines a single event, but it is allowed to repeat. However, 

repeating events are not allowed to overlap each other. This is easy to achieve in that, for 
example, you could configure a daily event with the default post-trigger of 72 hours. This would 
already result in three overlaps without a pre-trigger. Therefore, such overlaps are checked 
when the files are read in, overlap errors are output via message box and corrected. The 

corrective action is as follows: 
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First, the post-trigger is reduced as much as necessary, down to zero if needed. If this is not 
sufficient, the pre-trigger is reduced as much as necessary. Reducing the PreTrigger down to 

zero is never necessary.  

The possession of a Microsoft Office version for opening Excel files in XLSM format (e.g., 
PeriodicEvents.xlsm) is highly recommended for generating the CSV files (*.xlsm→ Export 
Button→ *.csv), since the alternative generation and/or editing of CSV files in a text editor is 
very cumbersome and error-prone (for details see next chapter). 

2. Purchasing a License 

Without a valid license, DesktopReminder will only run for 6 hours. However, there are no 
restrictions beyond this. A license costs €1 per year. A 10-year license (  quantity 10 in the store) 
therefore costs 10.- € and also entitles to updates until one day my secret key has to be replaced 
by me, which is by no means planned (only after compromising the previous secret key). A 
license always runs from the date of purchase, i.e., you cannot extend a license. This means: 

wait until it expires (or shortly before) and then buy a new one. Licenses are available in my 
store: 

https://kts-tools.de/produkt/desktop-reminder/ 

A purchased license file is sent by e-mail within 5 seconds after payment with PayPal. The e-

mail is typically delivered in less than 5 minutes. When paying by bank transfer, the license is 
also sent by e-mail immediately after receipt of the payment. 

The license sent by e-mail (a text file with the extension lic) must be copied or moved to the 
subdirectory ...\_License. After the next program start, it will be checked and the check result 
will appear in the list box. 

  

https://kts-tools.de/produkt/desktop-reminder/
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3. Description of the Directory Structure and Files 

After unpacking the ZIP file into any directory, the following subdirectories as well as the INI 
and help files are available.  

Subdirectory Content 

\_EmittedReminders\ Reminders sent out. To avoid repetitions of already completely processed 

reminders. 

\_Exports\ The DR offers several commands for creating text files. These files are stored in 
_Exports. 

\_Help\ The two help files (German and English) are stored there. 

\_IniFile\ The initialization file for user settings is stored there. 

\_License\ The license file is stored there. 

\_PeriodicEvents\ The periodic event configuration files (user input) are stored there. 

\Settings\ The selected language, the last DR window position and the number of 
preview/review days are stored there. 

\SingleEvents\ The one-time event configuration files (user input) are stored there. 

\_UserDocuments\ The user can "park" documents there. The DR does not use this subdirectory. 

DesktopReminder.exe The DR program file. 

The division of the event configurations into was chosen for convenience, although the user 

does not have to adhere to it. The user can store as many event files as desired in each of the 

two subdirectories. 

All files to be edited by the user are in Microsoft Excel XLSM format. The user should open these 
files with Excel, edit them and then save them in CSV format. The DR reads the files in CSV 
format. So, the processing chain is XLSM→ Export CSV→ Read in by DesktopReminder. All XLSM 
files contain an icon in the Excel Start menu ribbon to save the file in CSV format. Clicking the 
icon saves the file in CSV format and closes both the XLSM and CSV files immediately after the 

button is pressed.  

 

It is recommended to always open the Excel file from the CSV/XLSM pair because it is much 

better readable and also contains detailed comments that are lost in the CSV export. 

  

Symbol  
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3.1. Description of the Settings File 

The settings file is automatically saved each time the application is closed. It contains the last 

used language, DR window position and the last day value for the preview and review. 

When the program is started, the values last used are read in and applied. 

3.2. Description of the Initialization File 

The initialization file contains configuration options for the period duration of the calculations, 
the reminder output (message box or via a text editor), the DR window size after startup, DR 
window linking defaults, the preview, review and administration time spans, and the network 
path for additional schedule files.  

The initialization file contains four columns (INI value, keyword for the program as well as a 

German and an English description column). The description columns contain detailed fill -in 
help (if it is necessary to deviate from the default settings at all) . Please read the detailed 

descriptions of the INI configuration labels in the IniFile.xlsm file.  

3.3. Description of the Event Files 

The user has to enter his appointments in appointment files with arbitrary names. Please do 
not forget the CSV export after editing the XLSM file. Every single line leads to the output of a 

reminder at the configured time. Therefore, only one single line is shown below as a 
representative for all reminder entries: 

Who/What Display text Date Time 
Pre-

trigger  

[min] 

Repeats Interval Dictionary Key 

Thomas 
has a birthday. On %dat at %tim 

he turns %diff years old. 
01.02.1957 06:00:00 67 3 365  

Only the red column must be filled, otherwise no reminder can be issued. The grey and yellow 

column contents can be assigned by default (description see below) and can basically remain 
empty. The user should not make any entries in the dictionary key column. An Excel macro 

generates a unique key (for storage in a dictionary in DR.exe) during CSV export. Caution: When 
copying/pasting entire rows in the XLSM file, the key in the pasted row must be deleted because 
it is already used in the copied row.  

The individual cells in a reminder line are to be filled as follows: 

Headline Description of the content 

Who The first two cells are combined into a reminder sentence in the case of the sentence created by the 

DR. In the concrete example, the sentence would read: Thomas has a birthday. He will be 61 years old 
on 02/01/2018 at 07:00. The use of the placeholders %dat, %tim and %diff is explained below. Display text 

Date Enter the original date, e.g., the birthday to be remembered. Provided that you do not attach 
importance to a difference calculation (in order to output the new age in the reminder), you may of 

course also enter 01.02.2018. For a one-time reminder, the exact reminder date must be specified. 

Time The time at which the reminder is to be output. The cells are formatted as time in the Excel table and 

must remain so. 

Pre-trigger How long before the event should the reminder be issued? The specification is made in minutes. Entries 

of up to one million minutes are permitted, which corresponds to approx. 277 days. 
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Headline Description of the content 

Repeats The number of reminder repetitions before the event. The value 0 results in no repetition, i.e., a single 
output at the time of the event. The maximum possible number of repetitions is 30. 

Interval At what interval should the reminder be issued? The entry is made in days. There are several special 
treatments of entered values, which are described later in this chapter.  

The three placeholders %dat, %diff and %tim can be used as follows: 

Placeholder Description of the application 

%dat The DR replaces %dat in the reminder window with the date specified in the event file, but in which 
the year (e.g., 1957) is replaced by the current year. Example 01.02.1957: Thomas has birthday on %dat 
is then displayed as Thomas has birthday on 01.02.2022 in the reminder window. 

%diff The DR replaces %diff in the reminder window with the difference between the original date ( e.g., 
01/02/1957) and the current date (e.g., 01/02/2018) in years. Example: Thomas becomes %diff years 

is then displayed as "Thomas becomes 61 years" in the reminder window. 

%tim The DR replaces %tim in the reminder window with the time specified by the appointment file. 

Example: The meeting starts at %tim is displayed as "The meeting starts at 10:00:00" in the Reminders 
window. 

Default settings by default: 

After starting the DR, the internal default settings, which are not visible to the user, are loaded 

first (time: 00:00:00, pre-trigger: 0, repeats: 0, interval: 0). Therefore, the entries in the yellow 
fields are not mandatory, since the DR always has default settings. The user has the option to 

overwrite the program default settings by making an entry in the schedule file. This is done 
simply by adding a line under the keyword "Default", as shown in the following example:  

Who/What Display text Date Time 
Pre-run  
[min] 

Repeats Interval 

Default has a birthday (%diff).  07:00:00 0 3 365 

Each line under the keyword "Default" overwrites the previous user defaults. The number of 
default lines is not limited. The defaults are always valid until the next default line or until the 
end of the term file. You can also specify a default for the first column by following the keyword 
Default with = and the input, e.g., Default = SHIT-Meeting. The SHIT meeting is then used as the 
default for column A. 
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Special treatment of certain interval values: 

The DR offers the possibility to be reminded only on certain weekdays in certain months, for 
example on every second Sunday of a month. Several keywords are available for this, which are 

described in the table below: 

Keyword Example Description 

abs 120 abs 

abs = absolute value. The value 120 is divisible by 30 and would result in a reminder 

every 4 months without the addition of abs. An entry 120 on March 20, 2022 would 
result in a reminder on July 20, 2022. An entry 120 abs on the same day in March 
would result in a reminder on July 18, 2022. 

mwd 120 mwd -3 

month2weekday. Every 4th month (120) on the third last weekday (-3), e.g., Friday. 
The day of the week must be taken from the source date, because the two values 
that can be passed are already occupied by the month and the third last. The right 
value may be positive or negative. 

mmd 150 mmd -11 

month2monthday. Calculated every 5th month (150) on the 11th day back from 
the end of the month. The day of the original date is irrelevant. Both, positive and 
negative values are allowed, although positive values make no sense (can be 

achieved without special treatment; compare with a normal birthday entry). 

3.4. Description of the EmittedReminders File 

The DR stores the reminders already issued in the EmittedReminders.txt file to prevent cyclical 
repetitions. When the file is read back after the DR has been started, only the first three entries 

(each separated by <@@@>) are relevant, namely the dictionary key, the reminders already 
issued and the time of the last reminder (number of days since 1.1.1900 as a decimal number). 

The remaining information is only a control option for the user or programmer and is not used 
by the DR.  

The EmittedReminders. txt file is intended purely for use by the DR and not for editing by the 

user. But of course, the user is free to look at the file content. 

3.5. Description of the Export Files 

After entering some user commands, the DR creates text files in the _Exports directory. Files 
are written, for example, when the FutureEvents or MissedEvents button is pressed. If the user 

has configured via the INI file that all reminders are to be output in the text editor, then this 
text file is also created in the named subdirectory. The content of these files is easy to read and 

needs no further explanation.  

3.6. Description of the User Guide Files 

Two manual files (user manual in German and English) are available in PDF format in the _Help 
subdirectory. When executing the Open command, the respective file is opened in the standard 

PDF reader of the respective PC, depending on the currently active language.  
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4. Description of the Button Commands 

The commands described below are executed when the respective button is pressed. The 
buttons are provided with a tool tip describing the action of the push button. The following 

buttons are available: 

Button Description of the command 

Future Events Generates an appointment preview, the length of which can be specified in days via the Days input 

field. If the input field is empty, the value from the INI file (e.g., 72 hours = 3 days) is applied.  

Missed Events Creates an appointment review, the length of which can be specified in days via the Days input field. 

If the input field is empty, the value from the INI file (e.g., 72 hours = 3 days) is applied.  

Reload Data Re-reads all event files in the corresponding directories.  

Open Help Opens the help file in the standard PDF editor. 

Open Directory Opens the DR directory in Windows file explorer. 

Hide Window Sets the DR window to the Windows show state SW_HIDE, i.e., the DR window disappears without 
a trace. Use a combo box command to make the window visible again (via a DR instance to be 
restarted). Alternatively, use the key combination SHIFT CTRL d r. Press the keys one after the other 

with a short pause between each entry. 

Switch Language Switches between German and English each time you press it.  

Clear Listbox Deletes the contents of the list box. 

Stop LB Entries Stops entries in the list box or continues them after the check mark is removed. 

Days: Enter a daily value for preview/review of future or missed events. 
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5. Description of Combo-Box 1 (Documents) 

The following combo box commands for opening documents are available: 

Combo Box Entry Description of the command 

1. Open the Settings File Opens the named file. 

2. Open the Initialization File Opens the named file. 

3. Open the Emitted 
Reminders File 

Opens the named file. 

4. Open the _SingleEvents File Opens the file whose name is missing here (but is shown in the DR window). Since the 
user can add as many Single Events files as desired, from here on the concrete 

numbering depends on the number of existing files. 

5. Open the _PeriodicEvents 

File 

Opens the file whose name is missing here (but is shown in the DR window). Since the 

user can add as many Periodic Events files as desired, from here on the concrete 
numbering depends on the number of existing files. 

6. Open the Help.pdf File Opens the named file. 

7. Open the Hilfe.pdf File Opens the named file. 

8. Open the DesktopReminder 
Main Directory 

Opens the named directory in Windows File Explorer. 

9. Open the 
_EmittedReminders Sub-

directory 

Opens the named directory in the Windows file explorer. 

10. Open the _Exports Sub-

directory 
Opens the named directory in the Windows file explorer. 

11. Open the _Help Sub-

directory 
Opens the named directory in the Windows file explorer. 

12. Open the _IniFile Sub-

directory 
Opens the named directory in the Windows file explorer. 

13. Open the _SingleEvents 

Sub-directory 
Opens the named directory in the Windows file explorer. 

14. Open the _PeriodicEvents 

Sub-directory 
Opens the named directory in the Windows file explorer. 

15. Open the _Settings Sub-
directory 

Opens the named directory in the Windows file explorer. 

16. Open the _UserDocuments 
Sub-directory", 

Opens the named directory in the Windows file explorer. 

17. Open the configured 
Network Path 

Opens the named directory in the Windows file explorer. 

The numbering of the commands in the DR window is most likely different from the numbering 

in the table above, since the numbering depends on the number of Single/ Periodic Events files 
present. 
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6. Description of the Combo-Box 2 (Commands) 

The following Combo Box 2 commands are available: 

Combo Box Entry Description of the command 

1. Determine the Number of 

Running DR Instances 
Lists the currently running DR instances including their process ID. 

2. Pop-up all Hidden 

DesktopReminder Instances 

Makes the first DR instance pop up again, since only it can be made invisible. The 
invisibility of all subsequent instances is rejected. Alternatively, the first DR instance 
can be made visible again using the SHIFT CTRL d r key combination. Press the keys one 
after the other with a short pause between each entry. 

3. Reload the Settings File Reloads the settings file. 

4. Reload the Initialization File Reloads the INI file. 

5. Reload all Data Files Reloads all event configuration files. 

6. Listbox Content, copy it into 
the Windows Clipboard 

Copies the contents of the list box to the Windows clipboard. 

7. Listbox Content, show it 
within Standard Text-Editor 

Copies and opens the contents of the list box in a text file. 

8. Show the last Reminders in 
a Message Box 

Shows the last reminders since program start in a message box. The number of 
reminders is limited to 256. If this limit is exceeded, the oldest reminders are 

overwritten. 

9. Show the last Reminders in 

Standard Text-Editor 

Shows the last reminders since program start in a text file. The number of reminders is 

limited to 256. If this limit is exceeded, the oldest reminders are overwritten. 

10. Show the complete 

Reminder Input Dictionary in 
Standard Text-Editor 

Each configured event is internally transferred into a C++ structure. This command 
shows all configurations in a text file. 

11. Show the today's Reminder 
Input Dictionary in Standard 

Text-Editor 

Configured events are only loaded into RAM if an event is pending today (including pre- 
and post-trigger). This command typically shows only a small percentage of the 
configurations compared to the command above. If the PC is powered on at a day 
change (24:00→ 00:00), all configuration files are re-read to keep today's dictionary up 
to date.  

12. Select a Reminder File in 
the Listbox and create a File 

Preview 

The user can click on a file name in the list box and then execute this command. An 
event preview is generated only for the selected file, taking the entered day value into 

account.  

13. Select a Reminder File in 
the Listbox and create a File 
Look-back 

The user can click on a file name in the list box and then execute this command. An 
event review is generated only for the selected file, taking the entered day value into 
account.  

14. Select a Reminder Key Line 
in Listbox and open 

corresponding File 

The user can select a line in the list box that contains a valid key (e.g., [10/13/2022-
12:07:33-1695117825-1980003252]). The key can be in an event line or in a reminder 

that was just issued. The command opens the associated file and names the exact line. 

15. Select a Reminder Key Line 
in Listbox and determine next 
Event 

The user can select a line in the list box that contains a valid key (e.g., [10/13/2022-
12:07:33-1695117825-1980003252]). The command calculates the next event of this 
entry, no matter how far in the future it is. 

16. Select a Reminder Key Line 
in Listbox and determine last 
Event 

The user can select a row in the list box that contains a valid key (e.g., [10/13/2022-
12:07:33-1695117825-1980003252]). The command calculates the last event of this 
entry, no matter how far in the past it is. 

17. Create a Test-Reminder A tester reminder is generated for the purpose of "look & feel". 

18. Simulate a Date (Input of 
Date in the Days Edit Box) 

The user can simulate a date to check whether an expected reminder is issued or not.  
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7. Inserting the Desktop Reminder into the Windows Autostart 

The user probably wants the Desktop Reminder to start automatically together with Windows 
(or only a few seconds afterwards). This is not as trivial as you might think, because the logged-
in Windows user on the C:\ drive only has full access to a few subdirectories or does not have 
to answer any Windows queries ("You must confirm administrator permissions to continue").  

All subdirectories with full access without administrator rights are located in C:\Users\Public or 
C:\Users\Logged-inUser, e.g., the Downloads folder (C:\Users\LoggedInUser\Downloads). If 
you have not installed an additional hard disk (typically drive D:\) in your PC, you must copy the 
DR to one of the two folders mentioned, e.g., to C:\Users\Public\DesktopReminder\. Now right-
click on the DesktopReminder v1.40 (a).exe file and select the Windows command "Create 

shortcut". 

This DR shortcut must now be moved to the Windows Autostart (Startup) folder. There are the 

following options for this: 

1) Hold down the Windows key (between Ctrl and Alt) and press the R key (R for Run). A 
small window opens with the title Run. This window allows you to execute one of the 

many C:\Windows\System32 utility programs. Now type in the Run window: 
shell:startup. This opens the subdirectory C:\Users\LoggedInUser\AppData\ 

Roaming\Microsoft\Windows\ Start Menu\Programs\Startup in Windows file explorer. 
Now insert the DR shortcut at this point.  

2) Click in the Windows file explorer at the specified location (...\Startup). The problem 
here is that at least the AppData subdirectory is invisible as part of the complete path in 

the Windows default settings. Open the Windows Explorer. Click on Options (Windows 
10: View  Options, Windows 11: Dot Dot Dot Options). A window with the title Folder 

Options opens. In this window, select: View → Hidden files and folders → Show hidden 
files, folders and drives. You can then click through to the subdirectory ...\Startup and 

insert the DR shortcut here. 

3) Alternative way to make the hidden files and folders visible. This can be done via 

Windows → Windows Tools → Control Panel → Explorer Options → View → Hidden 

files and folders → Show hidden files, folders and drives. You can then click through to 
the subdirectory ...\Startup and insert the DR shortcut here. 

The trick of simply leaving AppData invisible and typing C:\Users\LoggedInUser\AppData\ 
RETURN or entering the complete path and ending with RETURN does not work. You then get a 

Windows error message "... was not found". Invisible is also invisible for Windows. 
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8. Revision List 

Date 
/Version 

Chapter Detailed description of the change or extension 

v1.20  
Very extensive changes with the aim of reducing processor load. From this version 
onwards, only entries that are due on the current date (minus PreTrigger plus PostTrigger) 
are checked (via pre-sorting at each day change). 

v1.30  
Simplification of the user settings. After each restart, the settings from the last session are 
loaded. Exception: Last window position. If this is outside the visible area (due to different 
monitor configurations), the start position of the window is corrected to 0/0. 

v1.40  
Flashing message box when a reminder is output: Shortened output for better readability. 
However, the long version is shown both in the list box (DR interface) and in the generated 

and opening text file. 

   

 


